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Ex.No 01 
INTRODUCTION TO MATLAB 

Date  

 

Aim: 

To Study the capabilities of Mat Lab Software. 

Introduction 

The MATLAB is a high-performance language for technical computing 
Integrates computation, visualization, and programming in an easy-to-use 

environment where problems and solutions are expressed in familiar mathematical 

notation. 

Typical uses include 

• Math and computation 

• Algorithm development 

• Data acquisition 

• Modeling, simulation, and prototyping 

• Data analysis, exploration, and visualization 

• Scientific and engineering graphics 

• Application development, including graphical user interface building 

MATLAB is an interactive system whose basic data element is an array that does not 

require dimensioning. It allows you to solve many technical computing problems, 

especially those with matrix and vector formulations, in a fraction of the time it 

would take to write a program in a scalar non interactive language such as C or 

FORTRAN. The name MATLAB stands for matrix laboratory. MATLAB was 

originally written to provide easy access to matrix software developed by the 

LINPACK and EISPACK projects. 

Today, MATLAB engines incorporate the LAPACK and BLAS libraries, 

embedding the state of the art in software for matrix computation 

 

SIMULINK INTRODUCTION: 

Simulink is a graphical extension to MATLAB for modeling and simulation 

of systems. In Simulink, systems are drawn on screen as block diagrams. Many 

elements of block diagrams are available, such as transfer functions, summing 

junctions, etc., as well as virtual input and output devices such as function generators 

and oscilloscopes. Simulink is integrated with MATLAB and data can be easily 

transferred between the programs. In these tutorials, we will apply Simulink to the 

examples from the MATLAB tutorials to model the systems, build controllers, and 

simulate the systems. Simulink is supported on Unix, Macintosh, and Windows 

environments; and is included in the student version of MATLAB for personal 

computers. 

The idea behind these tutorials is that you can view them in one window 

while running Simulink in another window. System model files can be downloaded 

from the tutorials and opened in Simulink. You will modify and extend this system 

while learning to use Simulink for system modeling, control, and simulation. Do not 

confuse the windows, icons, and menus in the tutorials for your actual Simulink 

windows. Most images in these tutorials are not live - they simply display what you 

should see in your own Simulink windows. All Simulink operations should be done 

in your Simulink windows. 

 

1. Starting Simulink 



 

2. Model Files 

3. Basic Elements 

4. Running Simulations 

5. Building Systems 

 

Starting Simulink 

Simulink is started from the MATLAB command prompt by entering the 

following command: 

>> Simulink 

Alternatively, you can hit the Simulink button at the top of the MATLAB window as 

shown below: 

When it starts, Simulink brings up the Simulink Library browser. 
 

 

Open the modeling window with New then Model from the File menu on the 

Simulink Library Browser as shown above. 

This will bring up a new untitled modeling window shown below 

Model Files 

In Simulink, a model is a collection of blocks which, in general, represents a 

system. In addition to drawing a model into a blank model window, previously saved 

model files can be loaded either from the File menu or from the MATLAB command 

prompt. 



 

You can open saved files in Simulink by entering the following command in 

the MATLAB command window. (Alternatively, you can load a file using the Open 

option in the File menu in Simulink, or by hitting Ctrl+O in Simulink.) >> Filename 

The following is an example model window. 
 
 

 

A new model can be created by selecting New from the File menu in any 

Simulink window (or by hitting Ctrl+N). 

Basic Elements 

There are two major classes of items in Simulink: blocks and lines. Blocks 

are used to generate, modify, combine, output, and display signals. Lines are used to 

transfer signals from one block to another. 

Blocks 

There are several general classes of blocks: 

Continuous 

Discontinuous 

Discrete 

Look-Up Tables 

Math Operations 

Model Verification 

Model-Wide Utilities 

Ports & Subsystems 

Signal Attributes 

Signal Routing 

Sinks: Used to output or display signals 

Sources: Used to generate various signals 

User-Defined Functions 

Discrete: Linear, discrete-time system elements (transfer functions, state-space 

models, etc.) 

Linear: Linear, continuous-time system elements and connections (summing 

junctions, gains, etc.) 

Nonlinear: Nonlinear operators (arbitrary functions, saturation, delay, etc.) 

Connections: Multiplex, Demultiplex, System Macros, etc. 

Blocks have zero to several input terminals and zero to several output 

terminals. Unused input terminals are indicated by a small open triangle. Unused 

output terminals are indicated by a small triangular point. The block shown below 

has an unused input terminal on the left and an unused output terminal on the right. 

 
Lines 

Lines transmit signals in the direction indicated by the arrow. Lines must 
always transmit signals from the output terminal of one block to the input terminal of 

another block. One exception to this is a line can tap off of another line, splitting the 

signal to each of two destination blocks, as shown below. 



 

 

 

Lines can never inject a signal into another line; lines must be combined 

through the use of a block such as a summing junction. 

A signal can be either a scalar signal or a vector signal. For Single-Input, 

Single-Output systems, scalar signals are generally used. For Multi-Input, Multi- 

Output systems, vector signals are often used, consisting of two or more scalar 

signals. The lines used to transmit scalar and vector signals are identical. The type of 

signal carried by a line is determined by the blocks on either end of the line. 

Simple Example 

 

 
The simple model (from the model files section) consists of three blocks: 

Step, Transfer Fcn, and Scope. The Step is a source block from which a step input 

signal originates. This signal is transferred through the line in the direction indicated 

by the arrow to the Transfer Function linear block. The Transfer Function modifies 

its input signal and outputs a new signal on a line to the Scope. The Scope is a sink 

block used to display a signal much like an oscilloscope. 

There are many more types of blocks available in Simulink, some of which will be 

discussed later. Right now, we will examine just the three we have used in the 

simple model. 

Running Simulations 

To run a simulation, we will work with the following model file: 
simple2.mdl Download and open this file in Simulink following the previous 

instructions for this file. You should see the following model window. 

 

 
Before running a simulation of this system, first open the scope window by 

double-clicking on the scope block. Then, to start the simulation, either select Start 

from the Simulation menu (as shown below) or hit Ctrl-T in the model window. 

 

The simulation should run very quickly and the scope window will appear as 

shown below. If it doesn't, just double click on the block labeled "scope." 



 

 
Note that the simulation output (shown in yellow) is at a very low level 

relative to the axes of the scope. To fix this, hit the autoscale button (binoculars), this 

will rescale the axes as shown below. 

 
Note that the step response does not begin until t=1. This can be changed by 

double-clicking on the "step" block. Now, we will change the parameters of the 

system and simulate the system again. Double-click on the "Transfer Fcn" block in 

the model window and change the denominator to 

[1 20 400] 

Re-run the simulation (hit Ctrl-T) and you should see what appears as a flat 

line in the scope window. Hit the autoscale button, and you should see the following 

in the scope window. 

 
 

Notice that the autoscale button only changes the vertical axis. Since the new 

transfer function has a very fast response, it compressed into a very narrow part of 

the scope window. This is not really a problem with the scope, but with the 



 

simulation itself. Simulink simulated the system for a full ten seconds even though 

the system had reached steady state shortly after one second. 

To correct this, you need to change the parameters of the simulation itself. In 

the model window, select Parameters from the Simulation menu. You will see the 

following dialog box. 

 

There are many simulation parameter options; we will only be concerned 

with the start and stop times, which tell Simulink over what time period to perform 

the simulation. Change Start time from 0.0 to 0.8 (since the step doesn't occur until 

t=1.0. Change Stop time from 10.0 to 2.0, which should be only shortly after the 

system settles. Close the dialog box and rerun the simulation. 

After hitting the autoscale button, the scope window should provide a much 

better display of the step response as shown below. 
 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Result 

Thus the features of MATLAB are studied. 



 

Ex.No 02 

STUDY OF BASICS IN ANSYS 
Date  

Aim: 

To study about the basic procedure to perform the analysis in ANSYS. 

Performing a Typical ANSYS Analysis: 

The ANSYS program has many finite element analysis capabilities, ranging from a simple, linear, 

static analysis to a complex, nonlinear, transient dynamic analysis. The analysis guide manuals in 

the ANSYS documentation set describe specific procedures for performing analyses for different 

engineering disciplines. The next few sections of this chapter cover general steps that are common 

to most analyses. 

A typical ANSYS analysis has three distinct steps: 

a. Build the model. 

b. Apply loads and obtain the solution. 

c. Review the results. 

1. Defining the Job name: 

The job name is a name that identifies the ANSYS job. When you define a job name for an 

analysis, the job name becomes the first part of the name of all files the analysis creates. (The 

extension or suffix for these files' names is a file identifier such as .DB.) By using a job name for 

each analysis, you ensure that no files are overwritten. 

2. Defining an Analysis Title: 

The TITLE command (Utility Menu> File> Change Title), defines a title for the analysis. ANSYS 

includes the title on all graphics displays and on the solution output. You can issue the /STITLE 

command to add subtitles; these will appear in the output, but not in graphics displays. 

3. Defining Units: 

The ANSYS program does not assume a system of units for your analysis. Except in magnetic field 

analyses, you can use any system of units so long as you make sure that you use that system for all 

the data you enter. (Units must be consistent for all input data.) 

4. Defining Element Types: 

The ANSYS element library contains more than 150 different element types. Each element type has 

a unique number and a prefix that identifies the element category: BEAM4, PLANE77, SOLID96, 

etc. The following element categories are available: 

Beam, Mesh 

Multipoint constraint 
 



 

5. Defining Element Real Constants: 

Element real constants are properties that depend on the element type, such as cross- 

sectional properties of a beam element. For example, real constants for BEAM3, the 2-D beam 

element, are area (AREA), moment of inertia (IZZ), height (HEIGHT), shear deflection constant 

(SHEARZ), initial strain (ISTRN), and added mass per unit length (ADDMAS). Not all element 

types require real constants, and different elements of the same type may have different real 

constant values. 

6. Defining Material Properties: 

Most element types require material properties. Depending on the application, material 

properties can be linear (see Linear Material Properties) or nonlinear (see Nonlinear Material 

Properties). As with element types and real constants, each set of material properties has a material 

reference number. The table of material reference numbers versus material property sets is called 

the material table. Within one analysis, you may have multiple material property sets (to correspond 

with multiple materials used in the model). ANSYS identifies each set with a unique reference 

number. 

7. Creating the Model Geometry: 

Once you have defined material properties, the next step in an analysis is generating a finite 

element model - nodes and elements - that adequately describes the model geometry. The graphic 

below shows some sample finite element models. 

There are two methods to create the finite element model: solid modeling and direct generation. 

With solid modeling, you describe the geometric shape of your model, and then instruct the 

ANSYS program to automatically mesh the geometry with nodes and elements. You can control the 

size and shape in the elements that the program creates. With direct generation, you "manually" 

define the location of each node and the connectivity of each element. Several convenience 

operations, such as copying patterns of existing nodes and elements, symmetry reflection, etc. are 

available. 
 



 

Apply Loads and Obtain the Solution: 

In this step, you use the SOLUTION processor to define the analysis type and analysis options, 

apply loads, specify load step options, and initiate the finite element solution. You also can apply 

loads using the PREP7 preprocessor. 

1. Defining the Analysis Type and Analysis Options: 

You choose the analysis type based on the loading conditions and the response you wish to 

calculate. For example, if natural frequencies and mode shapes are to be calculated, you would 

choose a modal analysis. You can perform the following analysis types in the ANSYS program: 

static (or steady-state), transient, harmonic, modal, spectrum, buckling, and sub structuring. 

Not all analysis types are valid for all disciplines. Modal analysis, for example, is not valid 

for a thermal model. The analysis guide manuals in the ANSYS documentation set describe the 

analysis types available for each discipline and the procedures to do those analyses. 

Analysis options allow you to customize the analysis type. Typical analysis options are the 

method of solution, stress stiffening on or off, and Newton-Rap son options. 

2. Applying Loads: 

The word loads as used in ANSYS documentation includes boundary conditions (constraints, 

supports, or boundary field specifications) as well as other externally and internally applied loads. 

Loads in the ANSYS program are divided into six categories: 

i. DOF Constraints 

ii. Forces 

iii. Surface Loads 

iv. Body Loads 

v. Inertia Loads 

vi. Coupled-field Loads 

You can apply most of these loads either on the solid model (key points, lines, and areas) or 

the finite element model (nodes and elements). 

3. Specifying Load Step Options: 

Load step options are options that you can change from load step to load step, such as 

number of sub steps, time at the end of a load step, and output controls. Depending on the type of 

analysis you are doing, load step options may or may not be required. The analysis procedures in 

the analysis guide manuals describe the appropriate load step options as necessary. 

1. Initiating the Solution: 

To initiate solution calculations, use either of the following: 

Command(s): SOLVE 

Main Menu> Solution> Solve> Current LS Main Menu> Solution> 

solution method 

Review the Results: 

Once the solution has been calculated, you can use the ANSYS postprocessors to review the 

results. Two postprocessors are available: POST1 and POST26. 

You use POST1, the general postprocessor, to review results at one sub step (time step) over the 

entire model or selected portion of the model. The command to enter POST1 is /POST1 (Main 

Menu> General Postproc), valid only at the Begin level. You can obtain contour displays, deformed 

shapes, and tabular listings to review and interpret the results of the analysis. POST1 offers many 



 

other capabilities, including error estimation, load case combinations, calculations among results 

data, and path operations. 

You use POST26, the time history postprocessor, to review results at specific points in the model 

over all time steps. The command to enter POST26 is /POST26 (Main Menu> Timeliest Postpro), 

valid only at the Begin level. You can obtain graph plots of results data versus time (or frequency) 

and tabular listings. Other POST26 capabilities include arithmetic calculations and complex 

algebra. 

 
Result: 

Thus the basic steps to perform the analysis in ANSYS like 

a. Build the model. 

b. Apply loads and obtain the solution. 

c. Review the results are studied. 



 

 
 

 

 

Observation:- 

Load Vector 

 
 

 

Deformed + Undeform shape 

 



 

Ex.No 03 
STATIC ANALYSIS OF CANTILEVER BEAM 

WITH UNIFORMLY DISTRIBUTED LOAD 
Date  

 

Aim:- 

To perform static analysis of given cantilever beam with uniformly distributed load 
by using ANSYS 15.0  analysis software. 

 

System Configuration:- 

Requirements 

System: Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0 software 

Procedure:- 

It involves three basic types of operations. 

1. Pre Processing 

2. Solution 

3. Post Processing 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ Beam/ 2 nodes 188/ok/close 

3. Material props/material models/structural/linear/elastic/isotropic/Exx = 2e5/PRxy=0.3 

/ok/close. 

4. Sections / Beam/Common section/Sub type -I section/Enter the dimension W1=20, 

W2=20, W3=30, t1=5, t2=5 and t3 = 8 mm/ok/close 

5. Modeling/Create/key points/ Inactive CS/x=0 y=0 z =0/Apply/x=1000 y=0 z=0/Apply 

x=0 y=50 z=0/ok. 

6. Modeling/Create/Lines/lines/In Active Coord/Select keypoint1 and track the mouse into 

select key point 2. 

7. Meshing/mesh tool/Element attributes/select line/set/pick orientation key point is yes/ 

select key point 3/ok. 

8. Meshing /mesh tool/size controls/lines/set/select line/Enter the value no of division=100 

or element length is 10/ok. 

9. Meshing /mesh tool/mesh/select the line/ok. 



 

Deflection Shear Force Diagram 

 

 

Slope Bending Moment Diagram 
 

 

Von mises Stress 
 



 

Solution:- 

10. Solution/Define Loads /Apply/Structural / Displacement /on key points/select key point1 

/All dof/ok. 

11. Solution/Define Loads /Apply/Structural / Pressure/on beams/Pick all/enter the pressure 

value of I = 2000/ok. 

12. Solutions/solve/current LS/solution is done. 

Post Processing:- 

13. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

14. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component of 

displacement. /plot controls/capture image. 

15. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Z component of 

rotation. /plot controls/capture image. 

16. Plot results for Contour plot/Nodal solu/Nodal solution/stress/ Vonmises stress/ok. /plot 

controls/capture image. 

17. Element table/define table/Add/by sequence num / SMISC5 / Apply/ SMISC18 / 

Apply/SMISC 2/Apply/SMISC 15/ok. 

18. Plot results /contour plot/ line element results/select SMISC 5 & SMISC 18/ ok. SFD 

will be plotted. /plot controls/capture image. 

19. Plot results /contour plot/ line element results/select SMISC 2 & SMISC 15/ ok. BMD 

will be plotted. /plot controls/capture image. 

 
Nodal solution:- 

 

S.No Parameters Maximum Minimum 

1 Deflection in mm   

2 Strain   

3 Bending Stress in N/mm2   

4 Bending Moment in N-mm   

5 Shear Force in N   

 

Result:- 

Thus the static analysis of a cantilever beam was performed by using ANSYS 15.0  analysis 

software. 



 

SIMPLY SUPPORTED BEAM 

 

 

 

Load Vector 

 

 

 
Def + Un deformed shape 

 



 

Ex.No 04 STATIC ANALYSIS OF SIMPLY SUPPORTED BEAM WITH 

UNIFORMLY DISTRIBUTED LOAD AND POINT LOAD Date  

 

Aim:- 

To perform static analysis of given simply supported beam with point load and 

uniformly distributed load by using ANSYS 15.0  analysis software. 

 

System Configuration: 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0 software 

Procedure:- 

It involves three basic types of operations. 

1. Pre Processing 

2. Solution 

3. Post Processing 
 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ Beam/ 2 nodes 188/ok/close 

3. Material props/material models / structural / linear / elastic / isotropic / Exx=1.9e5 

/PRxy=0.25/ok/close 

4. Sections / Beam/Common section/Sub type –square /Enter the dimension 

b=100,h=150, Nb=5 and Nh=5 /ok/close 

5. Modeling/Create/key points/ Inactive CS/x=0 y=0 z =0/Apply/x=3000 y=0 

z=0/Apply x=0 y=160 z=0/ok. 

6. Modeling/Create/Lines/lines/In Active Coord/Select keypoint1 and track the mouse 

into select key point 2. 

7. Meshing/mesh tool/Element attributes/select line/set/pick orientation key point is 

yes/ select key point 3/ok. 

8. Meshing /mesh tool/size controls/lines/set/select line/Enter the value no of 

division=100 or element length is 10/ok. 

9. Meshing /mesh tool/mesh/select the line/ok. 



 

Deflection 

 

 
 

Stress 

 

 
Slope 

 



 

Solution:- 

10. Solution/Define Loads /Apply/Structural / Displacement /on key points/select key 

point 1and 2/leave RotZ, All DOF and select others/ok. 

11. Solution/Define Loads /Apply/Structural / Pressure/on beams/Pick first 100 

elements/enter the pressure value of I = 3000/ok. 

Solution/Define Loads /Apply/Structural / Force/moment/on nodes /Pick 200th nodes 

/enter the value Fy = -2000/ok. 

12. Solutions/solve/current LS/solution is done. 

Post Processing:- 

13. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

14. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

15. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Z component 

of rotation. /plot controls/capture image. 

16. Plot results for Contour plot/Nodal solu/Nodal solution/stress/ Vonmises stress/ok. 

/plot controls/capture image. 

17. Plot results for Contour plot/Nodal solu/Nodal solution/stress/ Vonmises stress/ok. 

/plot controls/capture image. 

18. Element table/define table/Add/by sequence num / SMISC5 / Apply/ SMISC18 / 

Apply/SMISC 2/Apply/SMISC 15/ok. 

19. Plot results /contour plot/ line element results/select SMISC 5 & SMISC 18/ ok. SFD 

will be plotted. /plot controls/capture image. 

20. Plot results /contour plot/ line element results/select SMISC 2 & SMISC 15/ ok. 

BMD will be plotted. /plot controls/capture image 



 

Shear Force Diagram 

 

 
 

Bending Moment Diagram 

 



 

Nodal solution:- 

 
 

S.No Parameters Maximum Minimum 

1 Deflection in mm 
  

2 Slope in radian 
  

3 Stress in N/mm2 
  

4 Bending Moment in N-mm 
  

5 Shear Force in N 
  

 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

Result:- 

Thus the static analysis of given simply supported beam was performed by using 

ANSYS 15.0 analysis software. 



 

FIXED BEAM 

 

 
Young’s Modulus = 150 GPa 

Poisson’s ratio = 0.3 

 

Load Vector 

 
 

Def + Un deformed shape 

 



 

Ex.No 07 
STATIC ANALYSIS OF FIXED BEAM WITH UDL AND UVL 

Date  

 

Aim:- 

To perform static analysis of given fixed beam with point load by using ANSYS 

15.0 analysis software.  

 

System Configuration:-  

System : Windows 10 (64bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ Beam/ 2 nodes 188/ok/close 

3. Material props/material models / structural / linear / elastic / isotropic / Exx=1.5e5 

/PRxy=0.28/ok/close 

4. Sections / Beam/Common section/Sub type -I section/Enter the dimension 

Do=160,Di=125, Nb=5 and Nh=5 /ok/close 

5. Modeling/Create/key points/ Inactive CS/x=0 y=0 z =0/Apply/x=3000 y=0 

z=0/Apply x=0 y=160 z=0/ok. 

6. Modeling/Create/Lines/lines/In Active Coord/Select keypoint1 and track the mouse 

into select key point 2. 

7. Meshing/mesh tool/Element attributes/select line/set/pick orientation key point is 

yes/ select key point 3/ok. 

8. Meshing /mesh tool/size controls/lines/set/select line/Enter the value no of 

division=100 or element length is 10/ok. 

9. Meshing /mesh tool/mesh/select the line/ok. 



 

Deflection 

 

 

Stress 

 
 

Slope 

 



 

Solution:- 

10. Solution/Define Loads /Apply/Structural / Displacement /on key points/select key 

point 1and 2/Select All DOF /ok. 

11. Solution/Define Loads /Apply/Structural / Pressure/on beams/Pick first 100 

elements/enter the pressure value of I = 1000/ok. 

Solution/Define Loads /Apply/Structural / Pressure/on beams/Pick last 100 

elements/enter the pressure value of I = 0 and J = 1500/ok. 

12. Solutions/solve/current LS/solution is done. 

Post Processing:- 

13. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

14. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

15. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Z component 

of rotation. /plot controls/capture image. 

16. Plot results for Contour plot/Nodal solu/Nodal solution/stress/ Vonmises stress/ok. 

/plot controls/capture image. 

17. Plot results for Contour plot/Nodal solu/Nodal solution/stress/ Vonmises stress/ok. 

/plot controls/capture image. 

18. Element table/define table/Add/by sequence num / SMISC5 / Apply/ SMISC18 / 

Apply/SMISC 2/Apply/SMISC 15/ok. 

19. Plot results /contour plot/ line element results/select SMISC 5 & SMISC 18/ ok. SFD 

will be plotted. /plot controls/capture image. 

20. Plot results /contour plot/ line element results/select SMISC 2 & SMISC 15/ ok. 

BMD will be plotted. /plot controls/capture image 



 

Shear Force Diagram 

 

 
 

Bending Moment Diagram 



 

Nodal solution:- 

 
 

S.No Parameters Maximum Minimum 

1 Deflection in mm 
  

2 Slope in radian 
  

3 Stress in N/mm2 
  

4 Bending Moment in N-mm 
  

5 Shear Force in N 
  

 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
Result:- 

Thus the static analysis of given fixed beam was performed by using ANSYS 15.0  

analysis software. 



 

 
Young’s Modulus = 200 GPa 
Poisson’s ratio = 0.3 

Cross section area = 60 cm2 

 
Load vector 

 

 
 
 

Def + Un deformed shape 

 



 

Ex.No 06 
STATIC ANALYSIS OF A 2D TRUSS ELEMENT 

Date  

 

Aim:- 

To perform static analysis of given 2D truss element using ANSYS 15.0  

analysis        software. 

 

System Configuration:- 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 
2. Solution 

3. Post Processing 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ link/ 3D finit stn 180/ok/close 

3. Real constants/Add//edit/delete/Add/ok/Enter cross sectional area = 60 

4. Material props/material models / structural / linear / elastic / isotropic / Exx=2e9 

/PRxy=0.3/ok/close. 

5. Modeling/Create/Nodes/ Inactive CS/x=0 y=0 z =0/Apply/x=50 y=0 z=0/ Apply / 

x=100 y=0 z=0/ Apply /x=150 y=0 z=0/ Apply /x=125 y=50 z=0/ Apply /x=75 y=50 

z=0/ Apply / x=25 y=50 z=0 /ok. 

6. Modeling/Create/elements/Auto numbered/Throu nodes/Select keypoint1 and track 

the mouse into select key point 2.[similarly join all the points as per given truss 

diagram]. 

Solution:- 

7. Solution/Define Loads /Apply/Structural / Displacement /on key points/select 

node1and node 2/Select All DOF /ok. 

8. Solution/Define Loads /Apply/Structural / Force/moment/select nodes 5 and 7/enter 

the value Fy= -100/Apply/ select node 6/enter the value Fy= -200/ Apply/select nodes 

2 and 3/enter the value Fy= -10/ok 

9. Solutions/solve/current LS/solution is done. 



 

Deformation 

X – Displacement 

 
 

Y – Displacement 

 
 

Element stresses 



 

Post Processing:- 

10. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

11. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ X component 

of displacement. /plot controls/capture image. 

12. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

13. Plot results for Contour plot/Element solution/stress/Von mises stress/plot 

controls/capture image. 

14. Plot results for Contour plot/Element solution/Total mechanical strain/Von mises 

strain/plot controls/capture image. 



 

Element strain 
 



 

Nodal solution:- 
 

S.No Parameters Maximum Minimum 

1 X Displacement in cm 
  

2 Y Displacement in cm 
  

3 Stress in N/cm2 
  

4 Strain 
  

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
Result:- 

Thus the static analysis of given 2D truss element was performed by using 

ANSYS 15.0  analysis software. 



 

 
 

Young’s Modulus = 150 GPa 

Poisson’s ratio = 0.28 

 

 

Observation:- 

Load Vector 
 

 

Def + undef shape 

 



 

Ex.No 07 
STATIC ANALYSIS OF A 2D PLATE COMPONENT 

Date  

 

Aim:- 

To perform static analysis of given 2D plate component by using ANSYS 15.0  

analysis software. 
 

System 

Configuration:- 

Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ solid/ Quad 4 node 

182/ok/options/plane stress with thk/ok/close 

3. Real constants/Add//edit/delete/Add/ok/Enter cross thickness = 8 

4. Material props/material models / structural / linear / elastic / isotropic / Exx=1.5e5 

/PRxy=0.28/ok/close. 

5. Modeling/Create/Area / rectangle/By 2 corner/X = 0, Y=0, Width = 100 and Height 

= 50/ok 

6. Modeling/Create/Area/Solid circle/x= 50, y= 25 and radius = 12.5/ok 

7. Modeling/operate/Booleans/subtract/select area 1/apply/select area 2/ok 

8. Modeling/Create/area/solid circle/x= 10, y=10 and radius = 5/apply/x= 90, y=10 

and radius = 5/apply/x= 90, y=40 and radius = 5/apply/x= 100, y=40 and radius = 

5/ok. 

9. Modeling/operate/Booleans/subtract/select area 1/apply/select area 3, 4, 5&6/ok 

Solution:- 

7. Solution/Define Loads /Apply/Structural / Displacement /on lines/select all small 

circle’s periphery lines/ All DOF /ok. 

8. Solution/Define Loads /Apply/Structural / pressure/on lines/select big circles’ 

periphery lines enter the value of I = 500/ok 



 

9. Solutions/solve/current LS/solution is done. 

Displacement solution 

X- Displacement 

 
Y – Displacement 

 
 

Element Stress solution 



 

Post Processing:- 

10. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

11. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ X component 

of displacement. /plot controls/capture image. 

12. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

13. Plot results for Contour plot/Element solution/stress/Von mises stress/plot 

controls/capture image. 

14. Plot results for Contour plot/Element solution/Total mechanical strain/Von mises 

strain/plot controls/capture image. 



 

Element Strain solution 



 

Nodal solution:- 
 

S.No Parameters Maximum Minimum 

1 X Displacement in mm 
  

2 Y Displacement in mm 
  

3 Stress in N/mm2 
  

4 Strain 
  

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 

 
Result:- 

Thus the static analysis of given 2D plate component was performed by using 

ANSYS 15.0  analysis software. 



 

2D – ‘L’ BRACKET 
 

All Dimensions in mm 

 

Young’s modulus = 2 x 105 N/mm2 

Poisson’s ratio = 0.3 

 

Observation:- 

 

Load Vector 



 

Ex.No 08 
STATIC ANALYSIS OF A 2D L - BRACKET 

Date  

 

Aim:- 

To perform static analysis of given 2D L - bracket by using ANSYS 15.0  analysis 

software. 
System 
Configuration:- 
Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 
It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

Preprocessing 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ solid/ Quad 4 node 182 / ok / 

options/plane stress with thk/ok/close 

3. Real constants/Add//edit/delete/Add/ok/Enter cross thickness = 8 

4. Material props/material models / structural / linear / elastic / isotropic / Exx=2e5 

/PRxy=0.3/ok/close. 

5. Modeling/Create/Area/Rectangle/By 2 corner/X = 0, Y=25, Width = 50 and Height = 

125/apply/ X = 50, Y=100, Width = 75 and Height = 50/ok 

6. Modeling/Create/Area/circle/Solid circle/x= 25, y= 25 and radius = 25/apply/ x= 

125, y= 125 and radius = 25/ok. 

7. Modeling/operate/Booleans/Add/select area 1(rectangle 1)and area 3(circle 

1)/apply/select area 2(rectangle 2) and area 4(circle 2)/apply/select vertical area and 

horizontal area/ok 

8. Modeling/Create/Area/circle/Solid circle/x= 25, y= 25 and radius = 12.5/apply/ x= 

125, y= 125 and radius = 12.5/ok. 

9. Modeling/operate/Booleans/subtract/select area 1/apply/select area 5(small circle 

1)/apply/select area 2/apply select area 6(small circle 2)/ok 

10. Meshing/mesh tool/size controls/area/set(click)/select area/enter element size = 

2/ok 

11. Meshing/mesh tool/ mesh/ select area/ok. 



 

Observation:- 

 

Def + undef shape 

 

 
 

Displacement solution 

X- Displacement 

 

 
 

 
 

 
 

 
 

 
 
 

Y – Displacement 



 

Solution:- 

12. Solution/Define Loads /Apply/Structural / Displacement /on lines/bottom hole’s 

circle periphery lines/ All DOF /ok. 

13. Solution/Define Loads /Apply/Structural / pressure/on lines/select top hole’s circle 

periphery lines enter the value of I = 500/ok 

14. Solution/Define Loads /Apply/Structural / Force/moment/on nodes/select right side 

center node which is lies in upper hole/enter the value Fx = 1000/apply/ select top 

bottom side center node which is lies in upper hole/Fy = -1000/ok. 

15. Solutions/solve/current LS/solution is done. 

Post Processing:- 

16. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

17. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ X component 

of displacement. /plot controls/capture image. 

18. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

19. Plot results for Contour plot/Element solution/stress/Von mises stress/plot 

controls/capture image. 

20. Plot results for Contour plot/Element solution/Total mechanical strain/Von mises 

strain/plot controls/capture image. 



 

Stress solution 

 

 
 

Strain solution 



 

Nodal solution:- 
 

S.No Parameters Maximum Minimum 

1 X Displacement in mm 
  

2 Y Displacement in mm 
  

3 Stress in N/mm2 
  

4 Strain 
  

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
Result:- 

Thus the static analysis of given 2D truss element was performed by using ANSYS 15.0  

analysis software. 



 

AXISYMMETRIC ELEMENT 

 

 

 
 

Boundary condition 

 
Def – 2D 



 

Ex.No 09 
STATIC ANALYSIS OF AN AXI – SYMMETRIC COMPONENT 

Date  

 

Aim: 

To perform static analysis of thin cylindrical shell (axi-symmetric) component by 

using ANSYS 15.0  analysis software. 

System 
Configuration:- 
Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 
1. Pre Processing 
2. Solution 

3. Post Processing 

 
Preprocessing 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ solid/ Quad 4 node 182 / ok / 

options/Axisymmetric/ok/close 

3. Material props/material models / structural / linear / elastic / isotropic / Exx=2e5 

/PRxy=0.3/ok/close. 

4. Modeling/Create/Area/Rectangle/By 2 corner/X = 75, Y=0, Width = 10 and Height = 

500/ok. 

5. Meshing/mesh tool/size controls/area/set(click)/select area/enter element size = 

2/ok 

6. Meshing/mesh tool/ mesh/ select area/ok. 

Solution:- 

7. Solution/Define Loads /Apply/Structural / Displacement /on lines/select top and 

bottom lines/All dof/ok 

8. Solution/Define Loads /Apply/Structural /pressure/on lines/ select vertical inside 

line/ok/enter the pressure value = 10/ok 

9. Solution/Solve/Current LS/ok/Solution is done. 



 

Deformed shape – 3D 

 
Displacement solution 

X - Displacement 

 
Y - Displacement 



 

Post Processing:- 

9. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

10. Plot results for deformed/ Def + unreformed shape/plot controls/Style/size and 

shape/Display object /on/ok 

Plot controls/Style/size and shape/Symmetric expansion/2D axi-symmetric/select the 

options/ok/plot controls/capture image. 

11. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ X component 

of displacement. /plot controls/capture image. 

12. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

13. Plot results for Contour plot/Nodal solution/stress/ X component of stress/plot 

controls/capture image. 

14. Plot results for Contour plot/Nodal solution/stress/ Y component of stress/plot 

controls/capture image. 

15. Plot results for Contour plot/Nodal solution/Total Mechanical strain/vonmises 

strain/plot controls/capture image. 



 

Stress solutions 

Longitudinal stress 

 
Circumferential stress 

 

 
 

Strain solutions 



 

S.No Parameters Maximum Minimum 

1 X Displacement in mm 
  

2 Y Displacement in mm 
  

3 
Longitudinal Stress in 
N/mm2 

  

4 
Circumferential stress 
in N/mm2 

  

5 Strain 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Result:- 

Thus the static analysis of Axisymmetric element was performed by using ANSYS 15.0 

analysis software. 



 

SIMPLY SUPPORTED BEAM 

 
 

 
 

 
Load Vector 

 

 

Meshing of Model 

 



 

Ex.No 10 
MODAL ANALYSIS ON A SIMPLY SUPPORTED BEAM 

Date  

 

Aim:- 

To perform modal analysis of given simply supported beam with point load by 

using ANSYS 15.0  analysis software. 

 
System 

Configuration:- 

Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 
2. Solution 
3. Post Processing 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ Beam/ 2 nodes 188/ok/close 

3. Material props/Material library/ import library / Browse/[C-Drive/Program files/Ansys 

Inc/ v150 /ansys/ matlib /Stl_AISI-304.SI_MPL/ok 

4. Sections / Beam/Common section/Sub type –solid circular /Enter the dimension R = 

30 , Nb=5 and Nh=5 /ok/close 

5. Modeling/Create/key points/ Inactive CS/x=0 y=0 z =0/Apply/x=1000 y=0 

z=0/Apply x=0 y=75 z=0/ok. 

6. Modeling/Create/Lines/lines/In Active Coord/Select keypoint1 and track the mouse 

into select key point 2. 

7. Meshing/mesh tool/Element attributes/select line/set/pick orientation key point is 

yes/ select key point 3/ok. 

8. Meshing /mesh tool/size controls/lines/set/select line/Enter the value no of 

division=100 or element length is 10/ok. 

9. Meshing /mesh tool/mesh/select the line/ok. 



 

Observation:- 

 

First mode Second mode 

 

Third mode Fourth mode 

 

Fifth mode Sixth mode 



 

Solution:- 

10. Solution/Analysis type/New analysis/Modal 

11. Solution / Analysis type /Analysis options / No of modes to extract = 10 / No of 

modes to expand = 10 / ok / Start frequency = 0 / End frequency = 0 

12. Define Loads /Apply/Structural / Displacement /on key points/select key point 1and 

2/leave RotZ, All DOF and select others/ok. 

13. Solutions/solve/current LS/solution is done. 

Post Processing:- 

14. Read results/ first set. 

15. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. (First mode of frequency) 

16. Read results/ next set. (second mode of frequency) 

17. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

18. Repeat the above steps 16 & 17 for remaining 8 modes 



 

Seventh mode Eight mode 

 

Ninth mode Tenth mode 



 

Frequency at different modes:- 

 

Mode no Frequency in Hz 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

8 
 

9 
 

10 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 
 

Result:- 

Thus the modal analysis of given simply supported beam was performed by using 

ANSYS 15.0  analysis software. 



 

 
 

 

 
Observation:- 

 

Meshing of Model 

 

 
Load Vector 

 



 

Ex.No 11 
HARMONIC ANALYSIS ON CANTILEVER BEAM WITH UDL 

Date  

 

Aim:- 

To perform harmonic analysis on a Cantilever Beam with UDL by using ANSYS 

15.0 analysis software. 
 

System 

Configuration:- 

Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 
It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

Preprocessing:- 

1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ Beam/ 2 nodes 188/ok/close 

3. Material props/material models/structural/linear/elastic/isotropic/Exx = 

2e5/PRxy=0.3/ok/close 

4. Sections / Beam/Common section/Sub type -I section/Enter the dimension B= 50, 

H= 60/ok 

5. Modeling/Create/key points/ Inactive CS/x=0 y=0 z =0/Apply/x=1000 y=0 

z=0/Apply x=0 y=75 z=0/ok. 

6. Modeling/Create/Lines/lines/In Active Coord/Select keypoint1 and track the mouse 

into select key point 2. 

7. Meshing/mesh tool/Element attributes/select line/set/pick orientation key point is 

yes/ select key point 3/ok. 

8. Meshing /mesh tool/size controls/lines/set/select line/Enter the value no of 

division=100 or element length is 10/ok. 

9. Meshing /mesh tool/mesh/select the line/ok. 

Solution:- 

10. Solution/Analysis Type/ New Analysis/ Harmonic/ ok 

11. Solution / Analysis Type / analysis option/ ok/ Sparse solver/ ok 

12. Solution/ Load step option/ solution control/ Program chosen /ok. 



 

Frequency Vs Amplitude 

At x different locations (x= L) 

Linear 

 
Logarithmic 

 
Frequency Vs Amplitude 

At x different locations (x= L/2) 

Linear 

 



 

13. Solution/ Load step option/ Time/ frequency sub steps/ o to 500/ enter no of 

substeps = 10/ Stepped/ok 

14. Solution/Define the Loads /Structural / Displacement/on nodes/ (Pick node 1)all 

Dof/ok and Pressure 

15. Solution/Define the Loads /Structural / Pressure/on beams/ (Pick all) enter the 

pressure value at I = 200/ok 

16. Solution/ solve/ current LS / Solution is done/ close. 

Post Processing:- 

17. Time hist post processing/Add data/Nodal solution /DOF solution /Y component 

displacement. 

18. Time hist post processing /Graph data/ Capture image 

19. The same procedure was followed for different x locations. 

20. For better result/Plot cntrls/Style/Graph/modify axes/ Y-axis /Logarithmic 



 

Logarithmic 

 
Frequency – Strain 



 

Output:- 

 

 
S.No 

 

 
Description 

Linear Logarithmic 

 

Maximum 
Amplitude/stress 

/strain 

 

Frequency 

 

Maximum 
Amplitude/stress/ 

strain 

 

Frequency 

 

1 
 

Amplitude Vs Frequency at X = L 

    

 
2 

 
Amplitude Vs Frequency at X = L/2 

    

 
3 

 
Stress Vs Frequency 

    

 
4 

 
Strain Vs Frequency 

    

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
Result:- 

Thus the harmonic analysis on a cantilever beam with UDL was performed by using 

ANSYS 15.0  analysis software. 



 

 
 

 
Meshing of Model 

 

 
Displacement Solution 

Time: 5th Sec 

 



 

Ex.No 12  
TRANSIENT ANALYSIS ON A SIMPLE MECHANICAL ELEMENT Date  

 

Aim:- 

To perform Conductive heat transfer analysis on a 3D cube by using ANSYS 

15.0 analysis software. 

 
System 
Configuration 
Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

Preprocessing:- 

1. Thermal / h – method/structural 

2. Element type /Add/edits / delete / add/solid / Quad 4 node 182/ok/options/plane 

stress with thk /ok /close 

3. Real constants/Add//edit/delete/Add/ok/Enter cross thickness = 0.01 

4. Material prop/import lib/Browse/C drive/Program files/Ansys inc /v150/ ansys / mat 

lib /stl_AISI-304/ok/close. 

5. Modeling/create / Area /circle/ Solid circle / x=0, y=0, Radius = 0.05/Apply/ x = 0.3, 

y = 0 & R = 0.025/ ok. 

6. Modeling/create / Area /arbitrary/ throu key points/ select big circle top point 

first then select small circle top point/ then small circle bottom point and finally big 

circle bottom point/ ok. 

7. Modeling/ Operate/ Booleans/ add/ select area1/apply/area3/apply/ select area2/ 

apply /select area3/ ok. 

8. Modeling/create / Area /circle/ Solid circle / x=0, y=0, Radius = 0.04/Apply/ x = 0.3, 

y = 0 & R = 0.0175 / ok. 

9. Meshing/ mesh tool / mesh attributes/ area/set/select area/ok. 

10. Meshing/ mesh tool / size controls/ area/set/select area/ element length = 0.01 

/ok. 

11. Meshing/ mesh tool /area / mesh/select area/ok. 



 

Time: 10th Sec 

 
Time: 15th Sec 

 
Stress Solution 

Time: 5th Sec 



 

Solution:- 

12. Analysis type/ new analysis/ Transient/ok 

13. Analysis type/ soln control/ Time at end of load step = 5/ No of sub steps = 5/ Max 

no of sub steps = 5/ Min no of sub steps = 1/ok 

14. Define the Loads /Apply / structural/ displacement/ on line/select small hole’s inner 

lines/ all dof/ ok. 

15. Define the Loads /Apply / structural/ Pressure/ on line/ select Big hole’s inner lines/ 

Pressure value = 5/ ok. 

16. Load step option/ write LS file/ file no: 1/ ok. 

17. Analysis type/ soln control/ Time at end of load step = 10/ No of sub steps = 5/ 

Max no of sub steps = 5/ Min no of sub steps = 1/ok 

18. Define the Loads /Delete / structural/ displacement/ on line/select Big hole’s inner 

lines/ ok. 

19. Define the Loads /Apply / structural/ Pressure/ on line/ select Big hole’s inner lines/ 

Pressure value = 10/ ok. 

20. Load step option/ write LS file/ file no: 2/ ok. 

17. Analysis type/ soln control/ Time at end of load step = 15/ No of sub steps = 5/ 

Max no of sub steps = 5/ Min no of sub steps = 1/ok 

18. Define the Loads /Delete / structural/ displacement/ on line/select Big hole’s inner 

lines/ ok. 

19. Define the Loads /Apply / structural/ Pressure/ on line/ select Big hole’s inner lines/ 

Pressure value = 12/ ok. 

20. Load step option/ write LS file/ file no: 3/ ok. 

21. Solve/ From LS files/ starting file number =1/ ending file no = 3/ file increment = 

1/ok/ solution is done. 

Post Processing:- 

21. Read results / by pick / select first load step/read/ close. 

22. Plot results /Nodal solution /DOF solution/ Displacement vector sum/ ok. (Capture 

Image) 

23. Plot results /Nodal solution /stress/ von mises stress/ ok. (Capture Image) 

24. Plot results /Nodal solution / Total mechanical strain/ von mises strain/ ok. 

(Capture Image) 

25. Read results / by pick / select second load step/read/ close. 

26. Plot results /Nodal solution /DOF solution/ Displacement vector sum/ ok. (Capture 

Image) 

27. Plot results /Nodal solution /stress/ von mises stress/ ok. (Capture Image) 

28. Plot results /Nodal solution / Total mechanical strain/ von mises strain/ ok. 

(Capture Image) 



 

Time: 10th Sec 

 
Time: 15th Sec 

 
Strain Solution 

Time: 5th Sec 



 

29. Read results / by pick / select third load step/read/ close. 

30. Plot results /Nodal solution /DOF solution/ Displacement vector sum/ ok. (Capture 

Image) 

31. Plot results /Nodal solution /stress/ von mises stress/ ok. (Capture Image) 

32. Plot results /Nodal solution / Total mechanical strain/ von mises strain/ ok. 

(Capture Image) 



 

Time: 10th Sec 

 
Time: 15th Sec 



 

Nodal Results:- 

 

 
S.no 

 
Description 

 
Load step 1 

 
Load step 2 

 
Load step 3 

 
1 

 
Displacement 

 
Max 

 
Min 

 
Max 

 
Min 

 
Max 

 
Min 

 
2 

 
Stress 

      

 
3 

 
Strain 

      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Result: - 

Thus the transient analysis on a simple mechanical element was performed usinf 

ANSYS 15.0  analysis software. 



 

 
 

 

 

 

 

 

MESHING OF MODEL 

 



 

Ex.No 13  
CONDUCTIVE HEAT TRANSFER ANALYSIS ON A 3D CUBE Date  

 

Aim:- 

To perform Conductive heat transfer analysis on a 3D cube by using ANSYS 

15.0 analysis software. 

 
System 
Configuration 
Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

4. Pre Processing 

5. Solution 

6. Post Processing 

Preprocessing:- 

1. Thermal / h – method/thermal 

Element type /Add/edit / delete / add/solid / Brick 8 node 278/ok 

2. Material prop/import lib/Browse/C drive/Program files/Ansys inc/v150/ ansys / mat 

lib /stl_AISI-304/ok/close. 

3. Modeling/create / volume/block/by 2 corners &Z/ x=0, y=0, Length = 100, Width = 

100 and Height = 100/ ok 

4. Meshing/ mesh tool / smart size = 2 / sweep & hex /pick all/ok. 

Solution:- 

5. Define the Loads /Apply /Thermal / Temperature / on areas /select areas and enter 

temp value as per the diagram 

6. Solve/ current LS / solution is done. 

Post Processing:- 

8. Plot results /Nodal solution /DOF solution/Nodal temp/ok/ Plot controls/ Capture 

image. 

9. Plot results / Nodal solution / Thermal gradient solution/ Plot controls/ Capture 

image 

10. Plot results / Nodal solution / Thermal flux solution/ Plot controls/ Capture image 

11. Plot results/ element solu/ heat flow/ok/ Plot controls/ Capture image. 



 

Boundary condition 

 

 

Nodal Temperature 

 

 
Thermal gradient 



 

 



 

Thermal flux 

 

 

 
 

Heat flow 



 

Nodal solution:- 

 
 

S.No Parameters Maximum Minimum 

1 Nodal Temperature 
  

2 Thermal gradient w/m2 0 C 
  

3 Thermal flux w/m3 0 C 
  

4 Heat flow in Kg/0 C 
  

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
Result:- 

Thus the conductive heat transfer analysis was performed by using ANSYS 15.0  

analysis software. 



 

 
 

 

Meshing of Model / Boundary condition 

 

 
Nodal Solution 

Temperature Distribution 



 

Ex.No 15 CONDUCTIVE AND CONVECTIVE HEAT TRANSFER ANALYSIS 

ON A FURNACE WALL Date  

 

Aim:- 

To perform conductive and convective heat transfer analysis in furnace wall by 

using ANSYS 15.0  analysis software. 

 

System 

Configuration:- 

Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 
Preprocessing:- 
1. Thermal / h – method/thermal 

2. Element type /Add/edits / delete / add/solid / Quad 4 node 182/ok/options/plane 

stress with thk /ok /close 

3. Real constants/Add//edit/delete/Add/ok/Enter cross thickness = 1 

4. Material prop/ material model/ thermal/ conductivity / isotropic/ linear/kxx = 50/ 

density = 7.8e4 

5. Material prop//material model/ new model/ thermal/ conductivity / isotropic/ 

linear/kxx = 1/ density = 2e4/close 

6. Modeling/create / Area /circle/ Solid circle / x=0, y=0, width = 0.05 height = 0.75 

/Apply/ x = 0.05, y = 0 width = 0.1 height = 0.75 / ok. 

7. Modeling/operate/ Booleans/ glue/ select area1/apply/ select area 2/ok 

8. Meshing / mesh tool/ mesh attributes/ material no 1/ select area1/apply/material no 

2/ select area 2/ok. 

9. Meshing / mesh tool/ size control/ area / set/ select area/ element edge length = 

0.01/apply/ select area 2 / element edge length = 0.01/ok. 

10. Meshing / mesh tool/area/ mesh / select area 1/apply/ select area 2 /ok. 

Solution 

11. Define loads/ apply / thermal/ conduction / on lines/ select left side line/ enter the 

temp value = 500 



 

12. Define loads/ apply / thermal/ convection/ enter heat transfer film co efficient = 15 



 

Temperature Distribution 



 

Bulk temperature = 300/ok 

13. Solve/ current LS/solution is done/close. 

Post Process sing:- 

14. Plot results /Nodal solution /DOF solution/Nodal temp/ok/ Plot controls/ Capture 

image. 



 

 



 

Temperature at inside the wall = 500 K 

Temperature at outside the wall = 

 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

Result:- 

Thus the conductive and convective heat transfer analysis was performed on a furnace 

wall by using ANSYS 15.0 analysis software. 



 

 

Observation:- 
 

Deformed Results 

 



 

Ex.No 15 
THERMAL STRESS ANALYSIS ON BOILER SHELL 

Date  

 

Aim: 

To perform static thermal analysis of thin boiler shell (axi-symmetric) by using 

ANSYS 15.0  analysis software. 
 

System 

Configuration:- 

Requirements 

System : Windows 10 (64 Bit) 

Processor : Intel Core i3 

Speed : 3.60 GHz 

Ram : 4 GB 

HDD : 1 TB 

Software 

ANSYS 15.0  software 

Procedure:- 

It involves three basic types of operations 

1. Pre Processing 

2. Solution 

3. Post Processing 

 
Preprocessing 
1. Structural / h – method/structural 

2. Preprocessor/Element type/Add/edit/delete/Add/ solid/ Quad 4 node 182 / ok / 

options/Axisymmetric/ok/close 

3. Material prop/import lib/Browse/C drive/Program files/Ansys inc/v150/ ansys / mat 

lib /stl_AISI-304/ok/close. 

4. Modeling/Create/Area/Rectangle/By 2 corner/X = 0.5, Y=0, Width = 0.015 and 

Height = 0.75 /ok. 

5. Modeling/Create/Area/ circle/ By dimensions/outer radius = 0.515 / inner radius = 

0.5 /starting angle = 270 /Ending angle = 360/apply/ outer radius = 0.515 / inner 

radius = 0.5 /starting angle = 0/ Ending angle = 90/ok. 

6. Modeling/ move/modify/areas/area/Y offset = 0.75/ok 

7. Modeling / operate/ Booleans/ Add/ select area 1 and 2/apply/ select area 1 and 3/ 

ok. 

5. Meshing/mesh tool/size controls/area/ set (click)/select area/enter element size = 

0.001/ok 

6. Meshing/mesh tool/ mesh/ select area/ok. 

Solution:- 

7. Solution/Define Loads /Apply/Structural / Displacement /on lines/select top and 



 

bottom lines/All dof/ok 



 

Temperature Distribution 

 
Displacement Results 

X- Displacement 

 

 
Y- Displacement 



 

8. Solution/Define Loads /Apply/Structural /pressure/on lines/ select vertical inside 

line/ok/enter the pressure value = 5 e5/ok 

9. Solution/Solve/Current LS/ok/Solution is done. 

Post Processing:- 

10. Plot results for deformed/ Def + unreformed shape/plot controls/capture image. 

10. Plot results for deformed/ Def + unreformed shape/plot controls/Style/size and 

shape/Display object /on/ok 

11. Plot controls/Style/size and shape/Symmetric expansion/2D axi-symmetric/select 

the options/ok/plot controls/capture image. 

12. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ X component 

of displacement. /plot controls/capture image. 

13. Plot results for Contour plot/Nodal solu/Nodal solution/DOF solution/ Y component 

of displacement. /plot controls/capture image. 

14. Plot results for Contour plot/Nodal solution/stress/ Von mises stress /plot 

controls/capture image. 

15. Plot results for Contour plot/Nodal solution/Total Mechanical strain/von mises 

strain/plot controls/capture image. 



 

Thermal stress 

 
Thermal strain 



 

Nodal solution:- 

 
 

S.No Parameters Maximum Minimum 

1 X- Displacement in m 
  

2 Y – Displacement in m 
  

3 Thermal stress in N / mm2 
  

4 Thermal strain 
  

5 Nodal Temperature in K 
  

 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 

 
Result:- 

Thus the thermal analysis of given 2D plate element was performed by using ANSYS 

15.0 analysis software. 



 

 



 

ANNA UNIVERSITY: CHENNAI- 600 025 

B.E./B.Tech. DEGREE EXAMINATIONS, Nov./Dec.- 2014 

Regulations-2008 
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B.E. MECHANICAL ENGINEERING 

ME2404: COMPUTER AIDED SIMULATION AND ANALYSIS LABORATORY 

Time: 3 Hours Maximum Marks: 100 

1. Highlight the stress distribution on plate with circular hole as shown in Figure 1 and 

obtain the plot for deformed shape and stress distribution for given load and assume 

suitable boundary condition. Young’s modulus=2x105N/mm2; Poison’s ratio=0.3; 

Pressure Applied around the inside of the hole=25000N; Material properties: Linear, 

Elastic, and Isotropic. 

 
 

All dimensions are in ‘mm’. (100) 

 

2. Analyze the given L-Bracket for stress as shown in Figure 2 and obtain plot for stress 

distribution and deformed shape by applying suitable boundary condition. 

E=2x105N/mm2, Poisson’s ratio =0.3 Yield stress including safety factor 400 MPa. 

Options: Plane Stress; Real Constant: No need to define; Material Properties: Linear, 

Isotropic. 

 

All dimensions are in ‘mm’. (100) 



 

3. Obtain the stress distribution of an axi symmetric component shown in Figure 3. The 

model will be that of a closed tube made from steel. Point load of 50 KN will be applied 

at the centre of the top and bottom plate. 

All dimensions are in ‘mm’ (100) 

 

4. (a). A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 4(a) below. The cross-section of the 

beam is 132 mm x 264 mm while the modulus of elasticity of the steel is 210GPa. Find 

reaction, deflection and stresses in the beam. 

 (50) 

4. (b). Find the various modes of frequencies for the beam shown in Figure 4 (b). 

Modulus ofElasticity E=206800x106N/m2; Density=7830 kg/m3. All dimensions are in 

mm. 

(50) 

1. (a). A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 5(a). The cross-section of the 

beam is 150mm x 300mm while the modulus of elasticity of the steel is 210GPa. 

Find reaction, deflection and stresses in the beam. 

 

(50) 



 

5. (b) Find the various modes of frequencies for the beam shown in Figure5(b). 

Modulus of Elasticity E=206800x106N/m2; Density=7830 kg/m3. All dimensions in 

mm. 

 

 (50) 

6. (a) A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 6(a). The cross-section of the beam is 

572 mm x 1144 mm while the modulus of elasticity of the steel is 210GPa. Find 

reaction, deflection and stresses in the beam. 

 

 

 

 

 

 

 

 

 

 

 

(5 

0) 
 

6. (b) Find the various modes of frequencies for the beam shown in Figure 6(b). 

Modulus of 

Elasticity E=206800x106N/m2; Density=7830 kg/m3 

 
 

 
 
 

(50) 

 
7. Find the various modes of frequencies for the given 2D component shown in Figure 

7. All dimensions are in mm. 

 
 

 
 

 
 

 
 

 
 
 

(100) 



 

8. Find the various modes of frequencies for the given 2D component in Figure 8. All 

dimensions are in mm. 

 
 

 
 

 
 

 
 

 

 
(100) 

 

9. (a) Find the various modes of frequencies for the beam shown in Figure 9(a). 

Modulus of Elasticity E=206800x106N/m2; Density=7830 kg/m3 

(50) 
 

9. (b) A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 9(b) below. The cross-section of the 

beam is 572 mm x 1144 mm while the modulus of elasticity of the steel is 210GPa. Find 

reaction, deflection and stresses in the beam. 

 

 
 

 
 

 
 

(50) 

 
10. (a) Find the various modes of frequencies for the beam shown in Figure 10(a). 

Modulus of Elasticity E=206800x106N/m2; Density=7830 kg/m3 
 

(50) 

10. (b) A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 10(b). The cross-section of the beam 



 

is 150mm x 300mm while the modulus of elasticity of the steel is 210GPa. Find 

reaction, deflection and stresses in the beam. 

      (50) 

11. (a) Find the various modes of frequencies for the beam shown in Figure 11(a). 

Modulus of Elasticity E=206800x106N/m2; Density=7830 kg/m3 
 

(50) 
 

(b) A distributed load & Point load will be applied to a solid steel beam with a 

rectangular cross section as shown in the Figure 11(b). The cross-section of the beam 

is 132 mm x 264 mm while the modulus of elasticity of the steel is 210GPa. Find 

reaction, deflection and stresses in the beam. 

 

 
 

 
 

 

 
(50) 

 

12. Conduct a harmonic force response analysis on the cantilever beam shown in Figure 

12 by applying a cyclic load (harmonic) at the end of the beam. The frequency of load 

may be varied from1-100 Hz. Modulus of Elasticity E=206800x106N/m2; Density=7830 

kg/m3 

      (100) 



 

13. Perform a conduction analysis for temperature distribution on the block which is 

constrained as shown in the Figure 13. Thermal conductivity (k) of the material is 10 

W/m°C and the block is assumed to be infinitely long. 

                                     (100) 

14. A steel cooling spine of cross-sectional area A and length L extend from a wall 

maintained at temperature Tw (Figure 14). The surface convection coefficient between 

the spine and the surrounding air is h, the air temperature is Ta, and the tip of the 

spine is insulated. Apply advanced mesh control with element size of 0.025'. Find the 

heat conducted by the spine and the temperature of the tip. Material properties 
E= 2.1x105 N/mm2; ν = 0.33; k = 20 W/m K; 

Geometric properties A = 20 x 20 mm2; L = 120 mm 

Boundary conditions Tw = 100°T; Ta = 30°T; h = 50 W/(m2°K) 

 

 
 

 
 

 
 

 
 

 

(100) 

15. Analyze the given rectangular plate shown in Figure 15 for temperature distribution. 

Thermal conductivity of the plate, KXX=401 W/ (m-K) 

 

(100) 



 

16. Perform a simulation of an air conditioning system with condenser and evaporator 

temperatures as input to get COP using C/MAT Lab. Assume suitable variables. 

(100) 

 

17. Perform a simulation for the working of a double acting cylinder for any one 

application using C/MAT Lab. 

(100) 

 

18. Explain the step by step procedure for performing the simulation of cam and 

follower mechanism as shown in figure. Also perform the simulation using C/MAT Lab. 

 
 

 
 

 
 

 

 
 

 
 

 
 

(100) 

 

19. Analyse the given bracket (Figure 19) built from a 20 mm thick steel plate for 

deflection and Stress by treating it as plane stress condition. The material is steel. Take 

E=200 GPa and μ=0.25 

 

   (100) 



 

20. (a) Analyse the deflection and stresses in the beam shown in Figure 20(a). The 

cross section of the beam is 500 mm × 1500 mm. Take E=210 GPa. 

  (50) 

20. (b) Analyse the deflection and stresses in the simply supported beam shown in 

Figure 
20(b). The cross section of the beam is 500 mm × 1500 mm. Take E=210 GPa. 

 
 

 
 

 
 

 

 
(50) 



 

VIVA - VOCE QUESTIONS:- 
 

1. How to discrete the element in Ansys? 

2. What is translation motion? 

3. Define mesh attributes. 

4. What are degrees of freedom? 

5. What are the six degrees of freedom? 

6. What is boundary condition? 

7. Classify boundary condition. 

8. State the governing equation for one dimensional heat conduction problems. 

9. What are three process sing in Finite Element Analysis? 

10. What are the processes include in pre-process sing? 

11. What are the processes include in solution-process sing? 

12. What are the processes include in post-process sing? 

13. What is meant by nodal displacement? 

14. What is mode analysis? 

15. What is harmonic analysis? 

16. How to give UD load during stress analysis in beams? 

17. How to give UV load during stress analysis in beams? 

18. How to define simply supported beam while selecting types of beam? 

19. How to define the material during structural analysis in Ansys? 

20. How to define the material during thermal analysis in Ansys? 

21. Define poison’s ratio? Why it is required during analysis? 

22. What is elastic constant? 

23. State hooks law. 

24. What is factor of safety? 

25. What are the steps involved in design process? 

26. What is simulation? 

27. What are the software is available for simulation? 

28. What are the software is available for FEA? 

29. What are the software is available for Fluid dynamics? 

30. What is plane stress analysis? 

31. What is plane strain analysis? 

32. What is CST element? 

33. What is higher order element? 

34. What is meant by polynomial function? 



 

ALLOCATION OF MARKS 

 

 

S.No 
 

Particulars 
Maximum 

Marks 

Marks 

Obtained 

1 AIM & PROCEDURE 10 
 

2 MODELLING AND MESHING 40 
 

3 SOLUTION 20 
 

4 RESULTS 20 
 

5 VIVA- VOCE 10 
 

6 TOTAL 100 
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